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Arcsoft showbiz 3.5 manual

Copyright 2007 ArcSoft, Inc. All rights reserved. ArcSoft, the ArcSoft logo, and ArcSoft ShowBiz are registered trademarks of ArcSoft, Inc. in the United States. All other product and companies named herein may be trademarks of their respective owners. ArcSoft ShowBiz DVD 2 User Manual Table of Contents Introduction ... 1 Installation ... 3
System Requirements... 4 Workflow Overview ... 5 Capture... 7 Page 1 To get started with ShowBiz, first launch the program and select an option from the Welcome screen. This will take you to one of four modules: Create, Edit, Capture, or Quick DVD. The Capture module is where you record video and audio from various devices. You can choose
Video to capture footage from a DV camcorder or other connected device, or Audio to record sound clips, voiceovers, and other sounds. In the Video tab, playback controls appear when capturing from a DV tape, allowing you to navigate to a specific location on the tape. You can also use Auto Scan to find available channels and select your audio
device. If using a VFW device, such as an older webcam or USB device, select it from the pull-down menu and check the Audio Device box to record audio. Once ready, click the red Record button and save the captured video in the desired location, optionally setting scene detection during capture. Extracting music from a CD, or recording audio from
a sound device, provides two options for users to work with their audio content. If extracting audio from a CD is chosen, the user must first select the drive associated with that CD, allowing them to preview its tracks using standard playback controls. In the Edit module, four primary tabs are available: Media, Text, Transitions, and Effects. The Media
tab enables users to add various components to their video clip, including still images, video files, and audio files. The Player is a crucial component of the Edit module, providing a preview area on the right side of the screen and all necessary controls below it. This allows users to trim their video clip as they compile it using standard
play/pause/rewind buttons along with other controls depending on the previewed or recorded content. Additionally, two timers are available: one indicating the total playing time of the selected component, while the other shows the current time being viewed. The Media tab also allows users to organize their video content by browsing through
albums, which are collections of shortcuts to files stored on the system. Users can rename albums, add new files, and sort their album's content in various ways. Furthermore, scene detection makes it possible for users to break up long video clips into separate components without having to save each clip individually, allowing the program to scan the
selected video file and perform this task with ease. Chapter 3: Editing Components The Storyboard and Timeline are crucial components of the video editing process, where you arrange and combine video clip elements. The Storyboard acts as a template for video construction, allowing you to add still images or videos to specific spots. When saved,
these components merge into a single file. The swappable nature of the components enables drag-and-drop rearrangement. Use the arrows at the beginning and end of the Storyboard to access additional components not visible on screen. To split a video component, edit the timer to the desired position, right-click, and select Split. Combine split
videos by selecting them both, right-clicking, and choosing Combine. The Timeline provides an in-depth view of your constructed movie, allowing you to see every added component. Editing text effects involves clicking the Edit Text button on the left side of the Player. Adjust brightness, contrast, hue, and saturation using sliders. Modify display time
for still images with the top timer. In the Timeline, options include Undo and Redo commands for modifying components. The Text tab is divided into two categories: Style and Effect. Components from the Effect category are attached to the actual text messages from the Style category. The right column offers various text styles that can be chosen to
suit one's preference. Upon selecting the text, the mouse functions similarly to a word processor, allowing for easier editing. A checkbox enables the text to scroll as it is displayed, with separate buttons controlling the direction of added text. Chapter 3: Edit Transitions Transitions are special effects used between video clips or still images on the
Storyboard/Timeline. The Transitions tab offers various categories, and by clicking the arrow, these effects can be added to the timeline. Chapter 3: Edit Effects Special effects enhance movie quality and can be applied using the Effects tab. These include crop shapes, frames, and filters, which can be dragged onto video clips or still images on the
Timeline. Chapter 3: Edit Export The Export tab allows for various options when saving a video. All components on the Storyboard/Timeline are combined into a single file, which can be saved to a chosen location. You can customize the look and feel of chapter thumbnails on your menus by choosing from various thumbnail borders and arrangements.
If you update a thumbnail frame, you have the option to apply those changes to all thumbnails in the current menu or throughout the entire project by right-clicking and selecting "Apply frame to all thumbnails in this menu" or "Apply frame to all thumbnails in project". The Text tab allows for modification of any text appearing on menus by clicking on
the desired text in the preview area and making edits as needed, including changes to font, size, style (bold and italic), and color. You can also apply these settings to all other text on the current menu or throughout the entire project. In the Set Chapters tab, you can trim video clips and break them up into multiple chapters, with videos containing
multiple chapters automatically becoming submenus. This feature is only available for DVD projects. The preview area displays how your DVD menu will appear, allowing you to also play your DVD and use a virtual remote control to navigate through the menu as if on TV. Creating Unique Slides: A special movement effect is available for DVD projects;
see Section 7.8 for more details. Add Audio to Slides: You can attach music files to each slide by selecting the desired slide and clicking "Audio Annotation." Chapter 4: Create Once you've reached this stage, click "Next" to proceed. Transitions: These are effects that occur when one slide changes to another. Choose a pre-set effect or "All Effects
(Random)" to randomly insert transitions between slides. Transitions are only available for DVD projects. Chapter 5: Quick DVD This is the final step in creating your DVD or VCD. The top meter shows the available and required space, while the lower meter displays the progress of movie creation. The wizard guides you through each step of the
process. See Chapter 5 for editing a pre-created ArcSoft DVD. Recent Projects displays a list of recently opened projects. Under the Edit menu, commands include: * Undo: Reverses the last action * Redo: Reverses the last undo command * Cut: Removes and stores selected components * Copy: Places a copy in memory * Paste: Pastes previously cut or
copied items The View menu offers options like Capture, Edit, Create, TV Safe Zone, and more. (See Chapter 2-4 for details.) In the Options menu, you can adjust settings such as default display times, automatic scene detection, and video standards. The Play menu lets you start, pause, or stop playback of selected components. Extras & Help includes
updates, patches, and additional products from ArcSoft. Keyboard shortcuts include: * File: ALT + F * Edit: ALT + E * View: ALT + V * Options: ALT + O * Play: ALT + P * Extras: ALT + X * Help: ALT + H Page 68-69 provides additional shortcuts for the Capture, Player, and Project menus. Page 70: Chapter 6 - Menus, Page 72: Chapter 7 - How Tos
ShowBiz DVD can be overwhelming at first. To simplify the process, this chapter provides quick "how-to" guides for common tasks. **Capture Video** 1. Connect your camera to the computer and turn it on. 2. Launch the program and select "Capture, create, or edit videos." 3. From the next screen, choose "Capture from device." Alternatively, if
you're already in the program, click "Capture" at the top of the screen. *Capture Audio** 1. Open the program and go to the Capture module. 2. Click the Audio tab. 3. Select your recording source: a CD or audio device. If recording from a CD, choose the track and use playback controls to start recording where you want. **Create New Album** To
add content to the Storyboard/Timeline, create an album first. Albums are shortcuts linking to picture, music, and video files on your computer. 1. Create an album by [insert steps here]. **Add Content to Storyboard** The Storyboard is where you combine elements for your movie. It consists of squares: larger ones for STILL IMAGES and VIDEOS,
and smaller ones for TRANSITIONS (visual effects). When your final movie is compiled, everything on the Storyboard will be combined into a single video file. *Modify Content** This section covers simple content modifications on the Storyboard. For more advanced editing, see other sections. 1. Rearrange photos and videos by clicking and dragging
thumbnails to new locations on the Storyboard. 1. First, launch the program and click on “Create” at the top of the screen to access the Create module. 2. In the Edit module, you can apply the Pan & Zoom effect to photos or slides in slide shows created in the Create module. 3. To use the Auto-Pan & Zoom feature, select it from the options while
working on your project. 4. Previewing your work is essential to understand how the effects work and get an idea of the outcome. 5. On the Storyboard, you can perform basic content modification, including adding images, video clips, and transitions to enhance your movie. 6. To add text, click the Text tab, select the desired style, and drag it into the
Timeline. 7. Customizing menus involves organizing chapter buttons, choosing a new background, and modifying menu text. 8. Once you're satisfied with your project, click on the “Write Disc” tab in the Create module to preview, choose output options, and burn it to disc. ArcSoft Software License Agreement Please read this agreement carefully
before using the software provided by ArcSoft. By using the software, you agree to be bound by the terms and conditions outlined in this agreement. The software is intended for personal use only and cannot be used on a network server without a special license permit from ArcSoft. ArcSoft reserves all rights to the software and its contents. In no
event will ArcSoft be liable for damages exceeding the fees paid for the software. Any disputes or claims must be brought within 30 days of purchase, and both parties agree to exclusive jurisdiction in Santa Clara County courts. ArcSoft offers a range of imaging and video solutions for mobile phones, digital cameras, optical drives, personal
computers, and consumer electronics devices. Folder User Manual ArcSoft ShowBiz Text Editor 44601 Fremont Blvd., Fremont, CA 94538, USA Tel: +1.510.440.9901 Fax: +1.510.440.1270 www.arcsoft.com Copyright ArcSoft, Inc. All rights reserved. ArcSoft, the ArcSoft logo, and ArcSoft ShowBiz are registered trademarks of ArcSoft, Inc. in the
United States. To access various features of ArcSoft ShowBiz DVD 2, refer to the following sections: **Options**: Page 60 **Play**: Page 61 **Extras & Help**: Page 62 **Keyboard Shortcuts**: Page 63 **How Tos**: Pages 67-78 The application also includes video and audio capture capabilities, as well as tools for creating new albums, adding content
to storyboards, modifying existing content, and more. Explore the following chapters: *Capture Video**: Page 69 **Capture Audio**: Page 70 **Create New Album**: Page 71 **Add Content to Storyboard**: Page 72 **Modify Content**: Page 73 **Create DVD**: Page 74 **Create Slide Show**: Page 75 **Add Pan & Zoom**: Page 76 **Perform
Advanced Editing**: Page 78 Additionally, learn about designing menus and burning content to disc. For further assistance, refer to the following sections: **Reference**: Page 85 **Customer Support**: Page 86 **Technical Support**: Page 87 **Registering Your Product**: Page 88 **ArcSoft Product Family**: Page 89 **Licensing Agreement**: Page
92 **About ArcSoft**: Page 96 Finally, consult the index for a comprehensive overview of the user manual's contents. To access ShowBiz DVD 2, go to the Start menu. If the installer doesn't launch automatically, you can run it manually by inserting the CD into your CD-ROM drive and following these steps: Click Start>Run, type "X:/setup.exe" in the
Run dialog (where "X" is the drive letter associated with your CD-ROM drive), click OK, and then follow the on-screen instructions to complete the installation. To use ShowBiz DVD 2, you'll need a system that meets certain requirements. This includes running Windows 2000/XP/Vista, having at least 128 MB of RAM (512 MB is recommended), and a
Pentium III processor or higher (P4 1.6 GHz or higher is recommended). You'll also need a hard drive with a minimum of 400 MB available space for the program, as well as free space for video capture and editing (with at least 13 GB required for an hour of DV video). ShowBiz DVD 2 has four main modules: Capture, Edit, Create, and Quick DVD.
Each module serves a specific purpose, such as recording video and audio, editing videos, creating DVDs or VCDs, or quickly capturing video and burning it to disc. When you first launch ShowBiz DVD 2, the Welcome screen offers options for common starting places. Selecting an option takes you into one of the four modules: Create, Edit, Capture, or
Quick DVD. The Capture module is further divided into two tabs: Video and Audio, which allow you to record video from DV camcorders and other devices, as well as audio clips and sound effects. You can shoot video straight from your device and then review it afterwards. While capturing footage, the Record button will change into a Stop button.
When recording video from a DV camcorder, playback controls come up, letting you skip to specific parts on the tape. To capture something, click the red Record button after navigating to where you want to start. If you're capturing from a TV tuner, pick which channel you want to record and decide whether you also want to grab audio. For other
devices like webcams or capture cards, select them from the dropdown menu and tweak any necessary settings before hitting Record. Using newer webcams or devices may require selecting the WDM standard for video capture. The settings and options available depend on the chosen device. To record audio, check the Audio Device box and click the
Record button. After capturing, a Save As window will prompt you to enter a file name and save location. You can also select a save format, such as AVI for DV tapes. To stop capturing after a set time or include the video in an album, check the respective boxes during the Save As process. Scene detection can be set manually or automatically, with
options for separating scenes by date, time, or changes in content. Adjusting the sensitivity of automatic scene detection is also possible using a slider. When ready, click OK to start capturing. The program will begin recording video from your device. Use the Player's Stop button to stop recording and review the captured video. If scene detection was
enabled, an album thumbnail with a folder icon will be displayed, allowing you to view individual scenes. To get started, pick your audio settings and options from the Source button - these will vary depending on your sound capture device. Once ready, click Record in the Player and choose a file name and save location for your new audio. You can also
auto-save it to an album if you like. To stop recording, hit Stop within the Player. To play back your recording, click Playback and use standard playback controls. Later on, head over to the Edit module to assemble various components into a brand-new video clip. This is where you'll find four main tabs: Media, Text, Transitions, and Effects. These let
you add in still images, text overlays, fancy transitions, and special effects. When you've got content in your video clip, an extra tab called Export will appear. Here's where you can save all the components together as one video clip, perfect for use in your final DVD or VCD movie. The Player is another important part of the Edit module. It's like a mini-
TV screen on your computer that lets you preview and trim your video clip as you go along. You'll find standard play/pause/rewind buttons here, plus other controls that will depend on what you're working with. In the Edit module, Chapter 3 presents various features and functionalities, including timers, trim options, and media management. ##
Editing Timers Two timers are available: one displays the total playing time of a selected component, while the other shows the current time. The timer can be trimmed by clicking and dragging on the Start or End Marker, allowing for adjustments to the component's duration. ## Other Player Options Additional options include: - Printing the current
frame, - Saving the frame as an image file, - Viewing the preview window in full screen mode. These features enable users to customize their playback experience and organize media components more efficiently. ## Media Management The Media tab within the Edit module allows users to browse through albums, which are collections of shortcuts to
stored files. Albums can be added to or deleted without affecting the original files. Compiling a video clip involves adding media components to the Storyboard/Timeline, followed by selecting an album and arranging files accordingly. ## Album Management Within the Media tab: - Files can be added to albums using the "Add" button, - Albums can be
sorted in various ways, - A device can be used to capture images (Acquire), - The size of thumbnails can be adjusted (Sort). ## File Properties The currently selected file's properties, including file name and other details, are displayed to the right of the album thumbnails. These properties can be hidden if desired. Would like more thumbs shown at
once when viewing media. Choose "New Album" from dropdown menu, then select a 21 Chapter 3: Editting Video Scene Detection makes editing long vids a breeze by breaking them down into separate parts without needing to save each clip separately. The program scans the selected vid file and automatically breaks it up based on changes in time
or content. When you right-click on a video thumb in an album, you'll see an option called "Scene Detect." This command scans the vid and breaks it up into separate clips, which are displayed in a new window with fresh thumbs for each part. You can click and drag these thumbs to the Storyboard/Timeline just like any other media thumbnail. Scene
detection is noted on original thumbs with a folder icon in the bottom right corner. To remove scene detection, simply right-click the thumb and select "Delete Scene." 22 Chapter 3: Edit 3.4 Storyboard The Storyboard is where you arrange your video clips and still images to create a cohesive video. It serves as the template for your project, allowing
you to add components and save them all in one file. You can use this file in the Create module as a chapter in a DVD movie or leave it as a standalone file. When constructing a video, you can add components by going to the Media, Text, Transitions, and Effects tabs. The Storyboard displays the media and transitions you've added (excluding audio),
giving you a clear view of your project's progression. For a more detailed look at everything in your video, switch to the Timeline (see Section 3.5). The Storyboard is divided into several large squares, with smaller squares in between, making it easy to rearrange your components. You can navigate through multiple components in the Storyboard by
using the arrows at the beginning and end of the Storyboard, or scroll between them if they don't fit on screen. While working on your video's timeline, you have several editing options available: undo previous actions or redo a previously undone change to go back and forth between different stages of your video's development. Additionally, you can
split a single video into two separate components, recombine them by selecting both on the Storyboard, delete unwanted clips, record audio directly within the program, or use the Timeline to construct and arrange your video components. The Timeline offers a more detailed view of your constructed movie than the Storyboard, allowing you to see and
modify all added elements such as still images, videos, transitions, text, special effects, and audio tracks. You can expand or contract the Timeline using the "-" and "+" buttons to focus on specific areas or view multiple components at once. With our versatile platform, you can customize text effects not only on the entire track but also for each
individual text element. Additionally, you have control over alignment settings, allowing you to precisely position added text with ease. (Rewritten using "INCREASE BURSTINESS" method)
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